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Notas de version de Harmony 22.0.3

Harmony 22.0.3, versién 21960 (13-09-2023)

Correcciones

En esta versidn de Harmony y posteriores se han resuelto los siguientes problemas.

General

» Al copiar y pegar fotogramas clave de la linea de tiempo, es posible que se pegue un valor incorrecto
cuando se utilicen funciones de velocidad. HAR-9374

e Eluso repetido de los atajos de teclado para ir al dibujo anterior [F] o al dibujo siguiente [G] puede
omitir fotogramas en Windows y Linux. HAR-9411

¢ Al mantener pulsados los atajos de teclado para ir al fotograma anterior [,] o al fotograma siguiente [.],
se omiten fotogramas en Linux. HAR-9410

» Es posible que Harmony no pueda leer dibujos creados hace mas de 10 afos. HAR-9358

e Escribir caracteres coreanos de doble consonante no funciona en Windows y Linux. HAR-9080

Linea de tiempo

» Los marcadores de fotogramas desaparecen al arrastrar y colocar fotogramas en la linea de tiempo.
HAR-9448

Drawing (Dibujo)
¢ Harmony puede bloquearse al utilizar el comando Create Colour Art from Line Art (Crear color a partir
de linea) en dibujos que tienen tridngulos no validos. HAR-9461

Camara

¢ Se selecciona el color incorrecto cuando se utiliza el selector de color de la vista Colour Picker (Selector
de color) para seleccionar un color en la pantalla, si hay varias pantallas conectadas y se utiliza un
factor de escala distinto del 100 %. HAR-9198

Efectos y composicion

¢ Los efectos Highlight (Resaltar) y Tone (Tono) no se renderizan correctamente cuando las opciones Use
Matte Colour (Usar color mate) e Invert Matte (Invertir mate) estan activadas. HAR-9277

 Las particulas tienen un tamanio incorrecto cuando el campo de visién de la escena no estd configurado
en vertical. HAR-9325

¢ Harmony puede bloquearse al renderizar desenfoques gaussianos si el atributo Repeat Edge Pixels
(Repetir pixeles de borde) esta habilitado. HAR-9304
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» Todos los botones de opcidn de la pestania Enabling (Habilitacidn) del nodo de escritura tienen la
misma etiqueta. HAR-9383
Comandos
¢ DrawingTools.modifyStrokes de la interfaz de comandos extendida no se puede utilizar para cambiar el
grosor de un trazo de lapiz. HAR-9269
Importar/exportar
* No hay audio en las peliculas exportadas cuando Harmony estd en espanol. HAR-9360

¢ Es posible que Harmony se quede sin memoria al renderizar si hay un nodo de efecto Animate Pencil
Texture (Animar textura de lapiz) en una escena que tiene mas de 1200 fotogramas. HAR-9363

» El efecto Animate Pencil Texture (Animar textura de lapiz) no se aplica aleatoriamente cuando hay dos
nodos de dibujo o mas. HAR-9364

« El dltimo dibujo expuesto se renderiza en fotogramas vacios cuando se exporta mediante el comando
File > Export > OpenGL Frames... (Archivo > Exportar > Fotogramas OpenGL...). HAR-9121

WebCC

* Una escena exportada antes de actualizar a la versién 22.0.2 no se puede importar mediante WebCC
después de actualizar la base de datos con el nuevo archivo export.dict. HAR-9367
Centro de control
* Las paletas se importan al desactivar las opciones Palettes (Paletas) si Scene (Escena) y Backup (Copia
de seguridad) no estan desactivadas también. HAR-5105
Problemas conocidos

¢ Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la
extensidon que se abre para acceder a los botones se ocultard en las vistas que utilizan OpenGL. HAR-
8186

e Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el
selector de color nativo de macOS. HAR-8032

* Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del
Centro de control. HAR-6386

e Eltrazo permanece en su lugar después de eliminar el dltimo punto de una rama con la herramienta
Centerline Editor (Editor de linea central). HAR-5994

¢ Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un
doble clic. HAR-8801

e Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.



Notas de versién de Toon Boom Harmony 22.0.3

¢ En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 Premium"
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Notas de version de Harmony 22.0.2

Harmony 22.0.2, version 21617 (12-06-2023)
Mejoras

Utilidades

e La utilidad utransform ya puede imprimir y eliminar los metadatos de un archivo TVG con las opciones -
print_meta_data y -clear_meta_data. HAR-8421

Secuencia de comandos

» Ladescripcidn de la versidn de la escena ya se puede consultar y configurar con scene.Description y
scene.setDescription desde la interfaz de secuencias de comandos de Harmony. La descripcion también
se puede configurar al importar una escena desde el Centro de control con ImportData.impDescription.
El texto de la descripcidn tiene un limite de 200 caracteres UTF-8. HAR-8792

e Lafuncién JavaScript scene.closeSceneAndOpen tiene un nuevo parametro, isReadOnly, que permite
abrir una escena en modo de solo lectura. Por ejemplo, al usar scene.closeSceneAndOpen("Env", "Job",
"Scene01","1", true), se cerrara la escena actual y se abrird Scene01 (Escena01) en modo de solo
lectura. Solo se puede usar cuando se abre una escena en Harmony desde la base de datos. HAR-9042

* Se ha agregado la funcién de secuencia de comandos
SceneOffline.createDatabasePartialUpdatePackage para crear paquetes de actualizacion parcial para
cargarlos en WebCC. HAR-8875

¢ Elcomando TB_MayaBatchRenderModule.js se ha modificado para admitir renders utilizando el plugin
de renderizado 3Delight para Maya. HAR-9148

Correcciones

En esta versidn de Harmony y posteriores se han resuelto los siguientes problemas.

Camara

* Los pequefios cambios en el FOV de la cdmara no tienen ningun efecto y provocan interrupciones de
flujo al animar el FOV. HAR-9005

e El atajo de la tecla Tab para mover el pivote de la herramienta Transform (Transformar) no funciona.
HAR-8868

Herramientas y flujo de trabajo de dibujo

» Harmony se bloquea al cerrar una forma dibujada con un lapiz de texturas al mantener pulsada la tecla
Ctrl (tecla Comando en macOS) mientras Mirror View (Vista de espejo) esta habilitada. HAR-9011
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« Al dibujar con la herramienta Ellipse (Elipse) o Rectangle (Rectangulo) con ajuste, se puede dibujar en
la capa de dibujo incorrecta. HAR-8985

¢ Harmony puede bloquearse al rotar un dibujo con Ctrl+7 (tecla Comando+7 en macOS) mientras la
herramienta Select (Seleccionar) esta activa. HAR-9118

¢ Blogueo en raras ocasiones al usar la herramienta Stroke (Trazo). HAR-9123
» Bloqueos aleatorios en la herramienta Pencil Editor (Editor de lapices). HAR-9126
» El Contour Editor (Editor de contornos) crea bucles al ajustar vértices adyacentes. HAR-9131

* Las lineas de las capas no seleccionadas son dificiles de ver cuando Light Table (Mesa de luz) esta
habilitada y el espacio de color para trabajar esta establecido en Linear (Lineal). HAR-7446

* Un objeto de dibujo cortado no se pegara en la ubicacidon adecuada si hay un desplazamiento en la capa
de dibujo de origen o destino. HAR-8854, HAR-9168

* [Windows] Las miniaturas de Drawing Desk (Escritorio de dibujo) se muestran en baja resolucién en
monitores HiDPI. HAR-8885

¢ Lavista de dibujo a veces no se actualiza al cambiar el dibujo seleccionado en la vista de dibujo del
escritorio mediante los atajos de teclado Fy G. HAR-907/3

» |a preferencia «Light Table: Shade in Camera View» (Mesa de luz: Sombrear en vista de cdmara) no se
estd guardando. HAR-9075

¢ Los dibujos de la vista de referencia no se actualizan cuando se cambian los colores con Colour Picker
(Selector de color). HAR-9076

¢ [Linux] La herramienta de cuentagotas de Colour Picker (Selector de color) siempre selecciona los
valores RGB 0, 48,57. HAR-8778

» Los atajos de teclado de zoom y rotacidn se pueden usar mientras se dibuja. HAR-9077

* El atajo para cambiar a la herramienta Select (Seleccionar) no funciona en la vista de referencia. HAR-
9094

¢ Drawing View Magnifier (Lupa de la vista de dibujo) no funciona correctamente. HAR-9018

« Al eliminar un dibujo en la vista de sustitucidn de dibujos, que también estd vinculada en una columna
de tiempo de carta de rodaje, se puede provocar un bloqueo. HAR-9224

* Sise habilita Adjust Pencil Line Thickness (Ajustar grosor de lineas del lapiz) en Drawing Layer
Properties (Propiedades de capa de dibujo), es posible que se produzcan artefactos en las lineas del
lapiz al renderizar. HAR-9250

¢ Al aumentar las divisiones de ancho y altura en la herramienta Envelope (Envolvente), se puede
provocar un bloqueo. HAR-9264

¢ Los elementos y dibujos se duplican al cortar y pegar nodos de elementos en la vista de nodos. HAR-
9078
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Editor de funciones

La seleccién de varios puntos en una ruta 3D en Function editor (Editor de funciones) con la herramienta
de seleccién de recuadro no funciona. HAR-9103

Function editor (Editor de funciones) confirma un valor aleatorio en el fotograma clave seleccionado
cuando el campo Value (Valor) esté vacio y pierda el enfoque. HAR-8830

General

Al deshacer después de vincular y reordenar paletas se puede provocar un bloqueo. HAR-7725

Los dibujos duplicados se pueden perder al guardar una escena si las capas sincronizadas tienen el
mismo nombre base. HAR-8887

Si se copian varias capas sincronizadas desde una instancia de un personaje a otra, los dibujos nuevos
pueden perderse. HAR-8899

El cuadro delimitador de la herramienta Transform (Transformar) estd en la posicién incorrecta cuando
se utilizan dibujos de mapa de bits con deformadores ponderados o de forma libre. HAR-7787

Harmony se congela al intentar leer un archivo TVG que contiene metadatos. HAR-8409

Importar/exportar

Los archivos PSD guardados en Photoshop con el modo de compatibilidad deshabilitado no se
importan correctamente cuando se utiliza opcidn Single Layer (Una sola capa Unica). HAR-8849

Alimportar una imagen de layout PSD junto con su archivo XLI, se utiliza el archivo XLI de una imagen
importada anteriormente. HAR-9175

Harmony se bloquea al renderizar a imagenes SGl en escala de grises de 8 bits. HAR-9010

Al cambiar de nombre a una paleta, la lista de paletas no se marca como modificada, lo que hace que la
paleta no se guarde. HAR-9179

El nodo Multi Layer Write (Escritura multicapa) puede hacer que las sustituciones de dibujo adyacentes
se compongan en el mismo fotograma al exportar mediante Render Write Nodes (Renderizar nodos de
escritura). HAR-8228

Nodos y composicion

El nodo OGL-Controller (Controlador OGL) renderiza con suavidad el dibujo del cable que esta
conectado al puerto Controller Position (Posicién del controlador). HAR-8877

El nodo Deformation Composite (Composicion de deformacidn) bloquea la transformacién desde los
peg ascendentes. HAR-9034

Harmony se bloquea cuando OGL-Controller (Controlador OGL) tiene una etiqueta y la escala del peg
conectada estd establecida en 0. HAR-9102
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El nodo Matte-Resize (Cambio de tamafio de mate) puede provocar un error de renderizado. HAR-9163

El efecto Blur (Desenfoque) en los dibujos conectados a un nodo Highlight (Resaltar) o Tone (Tono) no
se procesa correctamente en la interseccién con el borde de la cdmara si la opcidn Invert Matte (Invertir
mate) estd habilitada. HAR-9181

El nodo Auto-Patch (Parche automatico) puede provocar un blogueo al renderizar y cambiar fotogramas
si se muestran miniaturas en la vista de nodos. HAR-9255

Rendimiento

Arrastrar y soltar fotogramas en la linea de tiempo puede ralentizarse con algunas escenas. HAR-8726

Las operaciones que implican cambiar el fotograma actual se vuelven mas lentas con mas controles de
Master Controller (Controlador maestro) visibles. HAR-8747

Integracion de renderizado y pipeline

Harmony se puede bloguear debido a dafos en la memoria al renderizar una escena por lotes si se
utiliza un gran nimero de subprocesos de renderizado. HAR-7875

A veces se pierden dibujos pequenos o sencillos de fotogramas renderizados al renderizarlos utilizando
varios subprocesos en procesadores rapidos. HAR-9012

Los softwares de terceros detectan el canal alfa de las peliculas renderizadas con ProRes 4444 0 4444
XQ como recto. HAR-7363

[Windows] El renderizado en ProRes en Windows redondea la resolucidn horizontal al multiplo de 16
pixeles mas cercano y recorta las imagenes renderizadas. HAR-9001

La exportacion a SGl en 16 bits provoca bloqueos o dafios en el color. HAR-9008

Harmony puede bloquearse al renderizar por lotes si las paletas se encuentran fuera de la escena.
HAR-9023

Colores incorrectos cuando la profundidad de procesamiento de la escena es de 32 bits y el formato de
exportacion estd establecido en 8 bits. HAR-9047

Harmony puede bloquearse al mostrar modelos 3D en la vista de perspectiva si la preferencia de
OpenGL «Enable composite passthrough for all effects» (Habilitar atravesar composiciones para todos
los efectos) esta habilitada. HAR-9082

El nodo Hold-Timing (Tiempo de hold) provoca problemas de actualizacién de OpenGL y un posible
bloqueo. HAR-9161

La seleccién con la tecla Mayus no funciona bien al desplazarse por la lista de trabajos de la cola de
renderizado. HAR-9117

Las peliculas exportadas con 23,976 fotogramas por segundo tienen los fotogramas por segundo
expresados como 2997/125 en lugar de 24000/1001. HAR-9109
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» Cuando se produzca un error al sobrescribir un archivo de pelicula existente porque se abra o bloquee
durante el renderizado por lotes, Harmony escribira la pelicula con un nombre Unico utilizando la fecha
y la hora. HAR-9133
Secuencia de comandos

¢ addNodeToSelectionNode, addNodesToSelectionNode y removeNodeFromSelection en la clase de
seleccidn no funcionan correctamente con telones de fondo. HAR-8391

* Lalibreria de multiprocesamiento de Python esta mal configurada cuando se ejecuta en Windows.
HAR-8567

e TB_RecolorDrawing.js no funcionara si un nodo de dibujo seleccionado no tiene un ID de elemento.
HAR-9062
Linea de tiempo y reproduccion

¢ La reproduccion se detiene momentaneamente al final cuando las opciones Loop (Bucle) y Sound
(Sonido) estan habilitadas. HAR-8988

¢ El atajo de teclado F para «Go to Previous Drawing» (Ir al dibujo anterior) omite las exposiciones de
teclas. HAR-9019

» Cuando la preferencia «Snap Keyframe» (Ajustar fotograma clave) estd habilitada, copiar y pegar un
fotograma clave en la linea de tiempo puede provocar un bloqueo. HAR-9199
Interfaz de usuario

» No es posible usar la tecla de retroceso para eliminar el Ultimo digito en algunos campos, como los del
cuadro de didlogo «Render Write Node» (Renderizar nodos de escritura). HAR-9009

» Escribir valores decimales en campos de entrada numéricos no funciona cuando el sistema operativo
estd configurado en francés. HAR-9016

¢ [Windows] Reproducir no funciona cuando hay una vista Camera (Camara) contraida en la zona de
trabajo. HAR-9141

* [Windows] Expandir una vista de camara oculta puede provocar un bloqueo si un monitor HiDPI tiene
habilitada la escala. HAR-9142

e [Linux] Focus On Mouse Enter (Centrarse en ratén) no siempre funciona. HAR-9095
¢ Los caracteres coreanos no se escriben correctamente. HAR-9080

e Harmony se bloquea si aparece la advertencia Auto-Save (Guardar automaticamente) al realizar una
operacion de arrastrar y colocar. HAR-9235

10
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Base de datos/Centro de control

» Copiar una escena en el Centro de control no funciona si la escena no esta seleccionada una vez que se
abre el cuadro de didlogo Copy Scene (Copiar escena). HAR-7888

* [WebCC] Los mensajes de notificacidn del sistema ya no aparecen una vez terminadas las
importaciones y exportaciones. HAR-8884

* WebCC deja de responder a las solicitudes de base de datos si estd inactivo durante 48 horas. HAR-
9114

¢ Elensamble de muchas escenas en WebCC genera un error [Error: EMFILE: too many open files... (Error:
EMFILE: demasiados archivos abiertos)]. HAR-9122

* El Centro de control no guarda la configuracidn «Get rights to modify all assets» (Obtener derechos
para modificar todos los activos) para los entornos. HAR-9074

¢ Cuando «Update Database Scene» (Actualizar escena de base de datos) falla, el informe de errores es
poco informativo y a veces incorrecto. HAR-8843

* Se puede bloquear la carpeta raiz, pero esto impide el bloqueo de cualquier otra carpeta de la base de
datos. HAR-8556

» Elrenderizado desde la interfaz de comandos del Centro de control no utiliza la cdmara predeterminada
de la escena a menos que se especifique por nombre. HAR-8403

¢ [Windows] WebCC no se inicia en una nueva instalacion de Windows porque MSVCR120.dlL no se
encuentra en la ruta. HAR-8873

¢ Con el comando «Update Database Scene» (Actualizar escena de base de datos), se puede daiar la
escena en la base de datos si esta se modificd después de exportarla sin conexion. Para resolver este
problema, se ha afiadido a Harmony 21.0.4 un nuevo archivo de diccionario llamado export.dict. El
archivo export.dict se debera copiar de forma manual en la carpeta /USA_DB/dicts/ de las bases de
datos de Harmony existentes. Las bases de datos nuevas creadas con Harmony 21.0.4 tendran el
nuevo archivo de diccionario. HAR-8858

Carta de rodaje

» Cuando el teclado estd establecido en francés, al presionar la tecla A en Carta de rodaje se bloquea
Harmony. HAR-9006

¢ Bloqueos aleatorios y en raras ocasiones en la interfaz de usuario de Carta de rodaje. HAR-9125

Problemas conocidos

¢ Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la
extensidn que se abre para acceder a los botones se ocultara en las vistas que utilizan OpenGL. HAR-
8186

11
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¢ Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el
selector de color nativo de macOS. HAR-8032

» Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del
Centro de control. HAR-6386

» Eltrazo permanece en su lugar después de eliminar el Ultimo punto de una rama con la herramienta
Centerline Editor (Editor de linea central). HAR-5994

¢ Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un
doble clic. HAR-8801

e Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.

¢ En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22
Premium"

12
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Notas de version de Harmony 22.0.1

Harmony 22.0.1 versién 22.0.1.19338 (2023-03-01)

Correcciones

En esta versidn de Harmony y posteriores se han resuelto los siguientes problemas.

Herramientas de dibujo

¢ Eluso de la herramienta Close Gap (Cerrar hueco) al dibujar con una tableta puede provocar un
blogueo. HAR-8828

» Laopcidn Paste Drawing Object in Place (Pegar objeto de dibujo en su lugar) no funciona cuando el
foco estd en la linea de tiempo o en la carta de rodaje. HAR-8606

Herramientas de animacion

¢ La herramienta Shift and Trace (Desplazar y trazar) no muestra el dibujo mientras se cambia de
posicion. HAR-8458

» Los agujeros de peg y los cabellos cruzados del dibujo anterior desaparecen después de mover el
dibujo con la herramienta Shift and Trace (Desplazar y trazar). HAR-8038

Linea de tiempo y reproduccion
¢ Create Cycle (Crear ciclo) desordena el tiempo de la capa y no se puede deshacer. HAR-3867

¢ Los marcadores de fotograma no se invierten cuando se utiliza el comando Paste Reverse (Pegar
inverso). HAR-7385

* Una capa establecida en el modo de contorno en la linea de tiempo siempre se muestra en negro en la
vista de camara. HAR-8573

e [Windows] La reproduccidn puede atascarse cuando se estén habilitados Loop (Bucle) y Sound
(Sonido). HAR-8808

Efectos

* Un dibujo vectorial conectado a un nodo Planer Region (Plano-region) que esta definido para utilizar
dibujo vectorial conectado a un emisor de sprite puede provocar un bloqueo. HAR-8763

¢ Ciertos efectos de sombreado pueden mostrar resultados no uniformes entre renderizado de 16 bits y
de 32 bits. HAR-8721

» El efecto de brillo produce artefactos cuando los atributos de alfa no estan establecidos en los valores
predeterminados y la escena esta configurada para renderizar en 32 bits. HAR-8752

* El efecto bokeh causa reflejos cuando hay un movimiento lento de la cdmara. HAR-8803

13
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Los efectos de bokeh y desenfoque renderizan con artefactos cuando esta habilitada la opcidén Enable
Graphic Card Acceleration (Habilitar aceleracidn de tarjeta grafica) en las preferencias. HAR-8802

Camara

3D

La opcidn Show Snapshot (Mostrar instantanea) en la vista de cdmara no muestra correctamente
ciertos efectos. HAR-8735

El limite del plano de recorte alejado de la cdmara no se puede elevar por encima de las 1000 unidades.
HAR-8805

Los modelos 3D vy las capas 2D desaparecen al rotar la vista en perspectiva 90 grados. HAR-8758

Deformadores

Los circulos de distancia minima y maxima mostrados para los deformadores ponderados no tienen el
tamano adecuado en las pantallas Retina/HiDPI. HAR-8610

Los circulos de distancia minima y maxima mostrados para los deformadores ponderados no se escalan
con el dibujo. HAR-8609

El uso de la herramienta Transform (Transformar) con Control Selection Mode (Modo de seleccidn de
control) habilitado no funciona en una cadena de deformacién recién creada. HAR-4650

Nodos y vista de nodo

Bloqueo al introducir texto en el campo de blsqueda de la vista de nodos. HAR-8850

Un nodo Channel Swap (Intercambio de canal) conectado directamente a una pantalla no renderiza
correctamente. HAR-8728

Bloqueo después de habilitar Publish Attribute Mode (Modo de publicacidn de atributos) y el atributo
Drawing (Dibujo) en el nodo Transformation Switch (Conmutador de transformacién). HAR-8848

Las opciones Timing Columns (Columnas de tiempo) en el nodo Transformation Switch (Conmutador
de transformacién) no funcionan correctamente. HAR-7796

El renderizado es incorrecto cuando un nodo selector de capa de dibujo se establece como aplanadoy
se utiliza en combinacién con el nodo Animate Pencil Texture (Textura de lapiz de animacién). HAR-
8809

La reduccidn del canal alfa mediante un nodo Matte-Resize (Cambio de tamafio de mate) no funciona si
la imagen de origen no tiene suavizado de contorno. HAR-8582

Importar/exportar

La importacion de imagenes desde el escaner se bloquea después de obtener una vista previa de las
imagenes. HAR-8818
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* Los archivos PSD de Adobe Photoshop 2021 y posteriores estan vacios en Harmony. HAR-8819

e Lasimagenesy los modelos 3D desaparecen de la escena si el nombre del archivo termina conuna vy
tres digitos (-v001). HAR-7118

¢ [Windows] El pegado de una imagen copiada de un navegador web no funciona. HAR-8796

o Pérdida de precisidn y bandas de color al escribir imagenes de 8 bits en JPG, TGA, TIF y SGI si hay una
conversion del espacio de color. HAR-8826

Secuencias de comandos

¢ La APl de Python de Toon Boom no puede cargarse a menos que se disponga de una licencia con base
de datos. HAR-8832

» Agregar la documentacion de la interfaz de Python al mend Help (Ayuda). HAR-8769

* Un dibujo creado mediante un comando de Python no estd marcado como existente en el sistema de
archivos, y no se puede cargar y renderizar inmediatamente. HAR-8856

e El comando TB_ExportCamera invierte la cdmara cuando algunos ejes se giran 180 grados. HAR-8647
¢ [Linux] Los paquetes de complementos/secuencias de comandos no se cargan al inicio. HAR-8812
e TB_GameExportWindow.js no esta empaquetado en Harmony 22. HAR-8811

» Agregar un método de comandos, setNumberOf a SCR_Framelnterface, que establece la duracién de
escena (mueve el controlador rojo final) sin borrar el dibujo ni el fotograma clave. HAR-7358

* Harmony se bloquea al renderizar un modelo 3D a través de la interfaz de secuencias de comandos de
Python. HAR-8750

Rendimiento
* [macOS] Harmony se bloquea a veces al reactivarse desde el modo de suspension. HAR-8359

» [macOS] Cuando se ejecuta en japonés, el asistente de licencias puede bloquearse al instalar el servicio
de licencias. HAR-8694

* La preferencia Save Scene Automatically (Guardar escena automaticamente) no funciona
correctamente cuando Harmony se deja en reposo. HAR-6564

e Las vistas superior y lateral tardan mucho tiempo en actualizarse mientras se renderizan las miniaturas.
HAR-8760

Dispositivos

» [Windows] Los gestos tactiles de la tableta Wacom para hacer zoom, panear y rotar no funcionan.
HAR-8739
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Interfaz de usuario

¢ [Windows] Al cambiar el tamafio de la ventana Preferences (Preferencias), esta puede desaparecer de
la pantalla si la escala de visualizacién no es del 100 %. HAR-8566

Base de datos/Centro de control

¢ Elinforme de errores de Update Database Scene (Actualizar escena de base de datos) es poco
informativo y a veces incorrecto. HAR-8843

« Lainformacién sobre el bloqueo de escenas no se muestra correctamente en el Centro de control. HAR-
8049

* [macOS] Después de cerrar una escena en el modo de base de datos, Open (Abrir), Palette Operations
(Operaciones de paleta) y otros comandos pueden dejar de responder. HAR-8766

Integracién de renderizado y pipeline

e Las paletas y las listas de paletas estan potencialmente bloqueadas durante el renderizado por lotes
normal. HAR-8667

¢ Harmony no funciona con el sistema de archivos de NAS en la nube LucidLink en macOS. HAR-8806

» |as estaciones de trabajo que no tienen una GPU pueden no tener instaladas las librerias OpenCL y
fallaran al cargar los complementos para los efectos OpenCL, como el desenfoque. HAR-8693

¢ Harmony se encuentra en estado "Not Responding" (No responde) durante mucho tiempo antes de
generar y cargar una vista previa de instantanea desde Producer. HAR-8817

* Las dependencias tbprocess/cola entre trabajos de renderizado no son correctas. HAR-8816

Otros
e Borrar una columna en la carta de rodaje y luego deshacerla puede provocar un bloqueo. HAR-8795

¢ El editor de metadatos no aplica correctamente los valores de los metadatos de escena. HAR-8748

Problemas conocidos

e Cuando no hay suficiente espacio para mostrar todos los botones de una barra de herramientas, la
extensidon que se abre para acceder a los botones se ocultara en las vistas que utilizan OpenGL. HAR-
8186

¢ Cuando se utiliza Harmony en macOS Big Sur, Harmony se puede bloquear al guardar un color en el
selector de color nativo de macOS. HAR-8032

* Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del
Centro de control. HAR-6386

e Eltrazo permanece en su lugar después de eliminar el ultimo punto de una rama con la herramienta
Centerline Editor (Editor de linea central). HAR-5994
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¢ Cuando se utiliza un iPad Pro en modo Sidecar con Harmony, cada segundo clic se registra como un
doble clic. HAR-8801

¢ Actualizar el sistema operativo a macOS Ventura puede ayudar a solucionar este problema.

¢ En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de
cuarentena del paquete de aplicaciones. HAR-7775

El atributo extendido de cuarentena se puede eliminar mediante el siguiente comando en el terminal:

sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22
Premium"
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Notas de version de Harmony 22

Esta es la lista de cambios en Harmony 22; versién 22.0.0.18839 (26-09-2022):

Nuevas funciones

Flujo de trabajo de dibujo

Caracteristica Descripcién

La vista de referencia (antes conocida como vista de modelo) ahora se puede
utilizar para importar y mostrar imagenes de mapa de bits que se pueden
utilizar como inspiracién o como referencias mientras se dibuja.

Reference View %

¢ R #4

Import References

/—’_\

:.'3‘“'
Se ha actualizado la vista de # 27 48,

modelo, que ahora se denomina
vista de referencia Las imdgenes importadas se guardan automdaticamente en la carpeta de
modelos de la escena. A continuacion, estas imagenes de referencia se pueden
cargar bajo demanda en sesiones posteriores mediante el comando Load

Default References (Cargar referencias predeterminadas).

Se ha agregado a la vista el nuevo comando Delete Current (Borrar actual)
para poder borrar las imagenes de la carpeta de modelos de la escena sin tener
que borrarlas manualmente mediante el explorador de archivos.

Ahora puede importar imagenes y dibujos a la vista de referencia arrastrando y
soltando desde un explorador de archivos o pegando imagenes desde el
portapapeles.

Ahora, la herramienta Pencil (Lapiz) muestra la textura del ldpiz, asi como el
Previsualizacion en vivo al patrén de grosor asignado al valor predefinido del lapiz seleccionado mientras
dibujar con textura de lapiz se dibuja la linea, lo que proporciona una previsualizacién en vivo y precisa de
la linea final.

Un nuevo comando denominado Paste Drawing Object in Place (Pegar objeto
de dibujo en el lugar) ya estd disponible en el ment Edit (Edicién). A diferencia
del comando Paste Drawing Object (Pegar objeto de dibujo), que pega un
Pegar en el lugar objeto de dibujo copiado con un ligero desplazamiento, el nuevo comando
Paste Drawing Object in Place (Pegar objeto de dibujo en el lugar) siempre
pega el objeto de dibujo copiado en la misma posicién que el original. Se puede
acceder al nuevo comando desde el menu Edit (Edicidn), y tiene asignado el
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Caracteristica

Descripcion

atajo de teclado Ctrl+Mayus+V (Command+Mayus+V en macOS).

Acceso directo Frame Drawing
Selection (Seleccidn de
fotograma)

Se ha agregado a Harmony un nuevo comando de acceso directo denominado
Frame Drawing Selection (Seleccién de fotograma). Al utilizar este comando
cuando una herramienta de dibujo estd activa, se centrara la vista de cdmara o
de dibujo en el dibujo seleccionado. El atajo de teclado predeterminado para
este comando es MayUs+F.

Renderizado

Caracteristica

Descripcidn

Procesamiento de renderizado
de 32 bits por canal

Ahora, las operaciones de renderizado internas en Harmony pueden realizarse
utilizando valores de punto flotante de 32 bits por canal. Esto proporciona mas
precisién y aumenta la compatibilidad con valores de color por debajode Oy
por encima de 1 para el renderizado de alto rango dindmico y precisién del
color.

La profundidad de bits que se utiliza para el procesamiento interno se puede
cambiar entre 16 bits o 32 bits por canal en la pestaiia Colour Space (Espacio
de color) de la ventana Scene Settings (Configuracidn de escena).

Cuando se seleccionan 16 bits por canal, las escenas se renderizan como en las
versiones anteriores de Harmony. Cuando se selecciona 32 bits por canal
(flotante), todas las operaciones de procesamiento interno se realizan con una
precisidn de punto flotante de 32 bits y no se recortan los valores de color a 1.
Esto permite a Harmony conservar los valores de color incluso cuando un
efecto eleva los valores de los colores mas alld del blanco, lo que permite que
los efectos posteriores recuperen esos colores al bajar los valores.

Las nuevas escenas creadas en Harmony 22 estan configuradas para utilizar el
procesamiento de renderizado de 32 bits por canal de forma predeterminada.
Las escenas de las versiones anteriores se ajustan a 16 bits por canal para que
sean compatibles con las versiones anteriores.

Compatibilidad con imagenes

Las imagenes EXR guardadas con una profundidad de color de punto flotante
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Caracteristica Descripcion

de 32 bits que contengan valores superiores a 1 ahora se pueden leer y sus
EXR de punto flotante de 32 valores se conservan durante todo el proceso de renderizado.

bits Harmony ahora también tiene la capacidad de escribir imagenes EXR con una

profundidad de color de punto flotante de 32 bits.

En la barra de estado de la vista de camara ahora se muestran los valores de
color del pixel que estd bajo el ratén cuando la vista de cdmara estd en Render
View Mode (Modo de vista de render). Los valores se expresan como nimeros
enteros entre 0 y 32767 cuando la escena estd configurada para renderizar en
16 bits por canal y como valores de punto flotante cuando la escena estd

Visualizacién de los valores de configurada para renderizar en 32 bits por canal.

color

Efectos y composicion

Caracteristica Descripcién

El efecto Bokeh Blur (Desenfoque de Bokeh) en Harmony simula el modo en
que el objetivo de una cdmara desenfoca los elementos en funcidn de la forma
de suiris.

Desenfoque de Bokeh

Para simular la profundidad de campo, se puede utilizar un mate alfa con este
efecto para controlar la cantidad de desenfoque aplicada a las distintas areas
de laimagen. Las dreas opacas en el mate alfa aplicaran el efecto por completo
mientras que las dreas transparentes en el mate alfa no aplicaran el efecto. El
nodo Bokeh Blur (Desenfoque de Bokeh) esta disponible en la libreria de
nodos en Filter > Blur (Filtro > Desenfoque).
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Caracteristica

Descripcién

&«

Bokeh Blur

Para obtener mas informacidn, consulte Nodo Bokeh-Blur (Desenfoque de
Bokeh).

Efecto Animar textura de lapiz

El nuevo nodo de efecto Animate Pencil Texture (Animar textura de lapiz)
funciona de forma similar al nodo Shake (Vibracién), pero en lugar de que
vibren los dibujos o la cdmara en la escena, aplica transformaciones aleatorias
a las texturas de las lineas de lapiz. Se puede utilizar para dar vida a los dibujos
simulando las lineas de ebullicién que se producen en las animaciones
dibujadas a mano, en las que se dibuja una nueva linea en cada fotograma.

El nodo Animate Pencil Texture (Animar textura de lapiz) puede detectar
automaticamente cuando hay una transformacién o un cambio de dibujo y
aplicar el efecto a la textura. No es necesario cronometrar el efecto ni mantener

la duracién manualmente.

EY,

Animate Pencil
Texture

El nodo Animate Pencil Texture (Animar textura de lapiz) estd disponible en la
categoria Filter (Filtro) de la libreria de nodos.

Modos de mezcla mejorados

Los modos de mezcla disponibles en los nodos Blending (Mezcla) y
Composite-Generic (Composicién genérica) se han actualizado para que sean
compatibles con el renderizado en escenas configuradas para utilizar el
procesamiento de 32 bits por canal, asi como para proporcionar resultados mas
cercanos a los modos de mezcla de aplicaciones de terceros.

Se ha simplificado la lista de modos de mezcla para eliminar los modos de
mezcla beta y anteriores. Sin embargo, para que sean compatibles con
versiones anteriores, los nodos Blending (Mezcla) y Composite-Generic
(Composicidn genérica) en escenas de versiones anteriores de Harmony
tendran la lista completa de modos de mezcla anteriores y beta. Las nuevas
instancias de estos nodos solo mostraran la lista actualizada.

Algunos modos de mezcla requieren valores fijos superiores a 1 para poder
ofrecer el mismo resultado que los software de terceros. Sin embargo, los
valores fijos limitan el uso de los modos de mezcla en el contexto de un
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Caracteristica

Descripcion

pipeline de HDR. Se ha introducido el nuevo atributo Clamping Mode (Modo de
fijacién) en los nodos Blending (Mezcla) y Composite-Generic (Composicidn
genérica) para controlar si los valores se deben fijar o no.

Mejoras en el nodo de efecto
Colour Curve (Curvas de
colores)

Se ha mejorado y ampliado el nodo Colour Curve (Curvas de colores) para que
sea totalmente compatible con las escenas configuradas para renderizar
utilizando el procesamiento de 32 bits por canal.

¢ Elnuevo atributo Clamp Output Values (Fijar valores de salida) se
puede utilizar para controlar si los valores se deben fijar en los valores
especificados en los campos Minimum (Minimo) y Maximum (Maximo).
Este atributo no estd disponible en el procesamiento de 16 bits por
canal.

¢ Elnuevo atributo Extrapolate Curve Bounds (Extrapolar limites de
curvas) extrapolara las curvas mas alla de sus primeros y ultimos
puntos. Este atributo no esta disponible en el procesamiento de 16 bits
por canal.

¢ Se ha agregado un control deslizante de zoom para poder alejar la vista
del grafico y manipular los puntos mas alla delrango Oy 1.
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Animacion

Caracteristica

Descripcion

Nuevos nodos de deformador
ponderado

Ya estan disponibles cuatro nuevos nodos de deformador ponderado en
Harmony. Estos se pueden utilizar para crear distintos tipos de sistemas de
deformador ponderado y controlar individualmente su influencia en la
deformacién global. Se pueden utilizar varios tipos de nodos de deformador
ponderado en el mismo sistema de deformacién para obtener mas flexibilidad.

Se encuentran disponibles los siguientes nodos nuevos:

¢ Weighted Point (Punto ponderado): el nodo Weighted Point (Punto
ponderado) utiliza el pivote de cada peg para crear el sistema de
deformacién. Se pueden agregar a sistemas de deformador ponderado
existentes para aplicar distintas influencias a grupos individuales de

pegs.

¢ Weighted Curve (Curva ponderada): se utiliza para definir una curva
que influye en el sistema de deformacién. Hay tres tipos de curvas
disponibles y se crean mediante pegs conectados al nodo.

¢ Weighted Line (Linea ponderada): crea una linea recta definida por los
pegs adjuntos. La linea resultante se utiliza para influenciar la
deformacién.

* Weighted Drawing (Dibujo ponderado): utiliza un tnico dibujo como
entrada que se utiliza para influenciar el sistema de deformacién. El
dibujo define la forma de la influencia y se puede transformar con un
peg para deformar el sistema global.

Los nuevos nodos de deformador ponderado estadn disponibles en la libreria de
nodos en Deformation > Weighted (Deformaciéon > Ponderado).

Nodo OGL Controller
(Controlador OGL)

El nuevo nodo OGL Controller (Controlador OGL) proporciona un controlador
seleccionable que se puede utilizar para seleccionar un dibujo o un peg en
cualquier lugar de la escena y que de otro modo seria dificil de seleccionar. Los
controladores OGL no se pueden ver en los renders de software, sino solo en
OpenGL.

El nodo proporciona formas basicas que se pueden utilizar como
representacién grafica del controlador. También se puede conectar un nodo de
dibujo para utilizarlo como controlador de forma personalizada.

Este nuevo nodo estd disponible en la libreria de nodos en la categoria
Controller (Controlador).
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Caracteristica

Descripcién

OGL Controller

Mejoras en los pivotes de las
herramientas Transform
(Transformar) y Translate
(Traslacién)

Se han realizado las siguientes mejoras en la representacidn graficay en la
manipulacidn de los pivotes cuando se utilizan las herramientas Translate
(Traslacién) y Transform (Transformar):

¢ Una nueva preferencia denominada Use a Donut-Style pivot (Utilizar un
pivote tipo donut) de la herramienta Transform (Transformar), situada
en la pestafia Advanced (Avanzado) en Preferences (Preferencias),
cambia el pivote circular de la herramienta Transform (Transformar) por
un donut, que permite seleccionar anclajes situados bajo el pivote a
través de su agujero central. Esta preferencia estd desactivada de forma
predeterminada.

¢ Una nueva preferencia denominada Allow Temporary-Pivot dragging
(Permitir arrastre de pivote temporal) en la vista de cadmara, situada en
la pestana Advanced (Avanzado) en Preferences (Preferencias),
desactiva la manipulacion interactiva del pivote de la herramienta
Transform (Transformar) cuando no esta marcada. Esta preferencia estd
activada de forma predeterminada.

¢ Se han agregado nuevos atajos de teclado para mover la posicion del
pivote temporal de la herramienta Transform (Transformar), asi como el
pivote de la herramienta Translate (Traslacién), sin tener que hacer clic
y arrastrarlo.

¢ Move Element or Peg Pivot to Cursor (Mover pivote de
elemento o peg al cursor): mueve el elemento seleccionado o el
pivote del peg a la posicién del ratén mientras la herramienta
Translate (Traslacidn) estd activa. La tecla Tab estd asignada
como el atajo de teclado predeterminado.

¢ Move Temporary Pivot to Cursor (Mover pivote temporal al
cursor): mueve el pivote temporal de la herramienta Transform
(Transformar) a la posicidn actual del cursor en la vista de
camara. La tecla Tab estd asignada como el atajo de teclado
predeterminado.

¢ Move Temporary Pivot to Default (Mover pivote temporal a
predeterminado): restablece el pivote temporal de la
herramienta Transform (Transformar) a su posicién
predeterminada. Atajo de teclado predeterminado: Ctrl+Tab en
Windows y Option+Tab en macOS
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Caracteristica

Descripcion

Consola de secuencias de comandos de Python y de
comandos de Python

.El modelo de objeto de documento Python de
Harmony proporciona una representacion en Python
de Harmony y del proyecto cargado. Esto permite la
creacidn de herramientas personalizadas y tareas de
automatizacion que se pueden ejecutar desde dentro
de Harmony utilizando la nueva consola de
comandos de Python, o externamente a Harmony
desde un intérprete de Python.

Este mddulo Python de Harmony es compatible con
Python 3.9 o posterior. Si el médulo se importa
desde la vista de consola de comandos de Python de
Harmony, se requiere la versién Python 3.9.x.

La consola de comandos de Python solo estara
disponible cuando Harmony se inicie en un entorno
que proporcione las librerias de Python. La ruta de
las librerias de Python se puede especificar
mediante la preferencia PYTHON_LIB_PATH o
dando acceso al archivo ejecutable de Python desde
la variable del entorno de PATH.

Para obtener mas informacidn, consulte la pagina
principal en la documentacién de la interfaz de
Python. Para acceder a la documentacidn, abra el
archivo index.html en la carpeta Documentation
(Documentacion) de la aplicacién de Harmony:

Windows:

C:\Archivos de programa (x86)\Toon Boom
Animation\Toon Boom Harmony 22
Premium\help\python\

macOS:

/Applications/Toon Boom Harmony 22
Premium/Harmony 22
Premium.app/Contents/Documentation/python/

Actualizaciones de las clases de Qt

Desde la actualizacion a Qt 6 de Harmony 21.1,
algunas clases de Qt que formaban parte del
paquete QtScriptBinding en las versiones anteriores
de Harmony han quedado obsoletas, se han
sustituido o no se han incluido en Harmony 21.1.

Todas las clases de Qt que faltaban ahora estan
empaquetadas con Harmony 22.
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Correcciones

General

La preferencia Focus on Mouse (Centrarse en ratdn) no funciona cuando el ratdn se mueve a una vista
de OpenGL. HAR-8218

BBox de la herramienta Transform (Transformar) esta en la posicidn incorrecta cuando se utilizan
dibujos de mapa de bits con deformadores ponderados y de forma libre. HAR-7787

BBox de la herramienta Transform (Transformar) esta en la posicién incorrecta cuando se utiliza un
deformador con un nodo de elemento que tenga un desplazamiento. HAR-8464

Bajo rendimiento al utilizar un nodo de intercambio de canal bajo una composicidn de transferencia.
HAR-8340

El orden de composicion de OpenGL es incorrecto cuando se utiliza el nodo Apply-Peg-Transformation
(Aplicar transformacion de peg) dentro de una escena 3D. HAR-8518

Faltan los colores de los vértices de los archivos de Alembic. HAR-8304

La preferencia Element Node “Animate Using Animation Tools” Default Value (Valor predeterminado
del nodo de elemento “Animar con herramientas de animacion”) se ignora cuando se importa un archivo
PSD de varias capas. HAR-6845

Los valores altos de espaciado del discretizador pueden hacer que el creador de distorsidn de
envolvente se bloquee. HAR-7396

No se suavizan las lineas de contornos durante la reproduccién. HAR-8262
A veces, Harmony se bloquea al abrir una segundo escena si el caché de nodo estd activo. HAR-8348

Al desconectar un cable de un nodo de deformador ponderado, a veces se desconecta el cable
incorrecto. HAR-8535

La aplicacion Scan se bloquea al intentar importar una imagen mediante el comando Load From File
(Cargar desde archivo). HAR-8350

H.264/MP4 no esta disponible como formato de exportaciéon cuando se ejecuta Harmony en un sistema
Apple Silicon. HAR-8188

Drawing (Dibujo)

Las miniaturas no se actualizan correctamente en la vista de sustituciones de dibujo. HAR-7493

Las opciones Draw Stroke as Straight Lines (Dibujar trazo como lineas rectas) y Connect Line Ends
(Conectar extremos de linea) de la herramienta Stroke (Linea vectorial transparente) no funcionan.
HAR-8416

Los vectores no se desplazan al pegarlos varias veces en otra capa de dibujo. HAR-8436

26



Notas de versién de Toon Boom Harmony 22.0.3

¢ La vista de dibujo no se actualiza inmediatamente cuando se cambian las opciones de desplazar y trazar
del escritorio de dibujo. HAR-8487

» Hay pequefios huecos en las uniones de colores después de utilizar el pincel de patrén en el modo de
repintado. HAR-8417
Vista de referencia
* Las capas no se pueden arrastrar desde la linea de tiempo a la vista de referencia (modelo). HAR-8323

» Arrastrary soltar una plantilla desde la libreria hasta la vista de referencia (modelo) no funciona. HAR-
8547

¢ La vista de referencia utiliza la tecla Suprimir en lugar de la tecla Retroceso para descargar los dibujos.
HAR-8539
Renderizado

e La opcidn Turbulent Noise (Ruido turbulento) se desplaza cuando se agrega un efecto de desenfoque a
continuacion. HAR-7789

e Lasimagenes EXR del nodo Multi Layer Write (Escritura multicapa) tienen varios fotogramas apilados
uno encima de otro. HAR-8228

» El atributo Alignment Rule (Regla de alineacion) no funciona en los renders de software con algunos
archivos JPEG. HAR-7335
Controladores maestros

¢ Se deja de analizar el estado de rig del Controlador maestro cuando se alcanza un valor pequeno o alto.
HAR-8412

e La adicidn o eliminacién de filas y columnas no funciona desde el Asistente de cuadricula del
Controlador maestro. HAR-8564
Secuencias de comandos

¢ Elcomando SCR_DrawingKey siempre devuelve el resultado nulo cuando se proporciona una clave de

dibujo en las secuencias de comandos. HAR-8407

» Lainterfaz de secuencias de comandos del Centro de control siempre renderiza la camara
“predeterminada” si no se especifica ninguna camara. HAR-8403

» El comando QByteArray no se puede construir con una cadena como argumento de construccion. HAR-
8497

¢ Los botones mas (+) y menos (-) son invisibles en TB_ExportToEaseUS, TB_ExportToSpriteSheets y
TB_SelectionPreset. HAR-8500
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¢ Link Server no funciona en Linux si no hay un servidor con un sistema de ventanas X. HAR-8563

» Se puede bloquear la carpeta raiz, pero esto impide el bloqueo de cualquier otra carpeta de la base de
datos. HAR-8556

e Las paletas se bloquean al renderizar escenas por lotes si se recuperan los colores. HAR-8536
» Laimportacion de escenas en el modo por lotes bloquea el Centro de control si la escena ya existe.

HAR-8503

Problemas conocidos

» Cuando no hay suficiente espacio para todos los botones de una barra de herramientas, la extensién
que se puede abrir para acceder a los botones se oculta cuando se abre sobre una vista de OpenGL.
HAR-8186

* Los gestos tactiles para hacer zoom, panear y rotar no funcionan en Windows. HAR-8739

¢ Cuando se utiliza Harmony en Big Sur, Harmony se puede bloquear al guardar un color en el selector de
color nativo de macOS. HAR-8032

* Las escenas de la base de datos que tienen una ruta personalizada no se pueden copiar a través del
Centro de control. HAR-6386

» Eltrazo permanece en su lugar después de eliminar el ultimo punto de una rama con la herramienta
Centerline Editor (Editor de linea central). HAR-5994

¢ En macOS Mojave, GateKeeper impide iniciar Harmony a menos que se elimine el atributo extendido de
cuarentena del paquete de aplicaciones. El atributo extendido de cuarentena se puede eliminar
mediante el siguiente comando en el terminal:

sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony
21.1 Premium"
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